
CSC 433/533

Computer Graphics

Review

Course Material Source Credits

Transformations in 2D

Short version 

We will discuss transformation in 3D, and with full details, later in the course 

(will need Matrix Multiplication and Homogenous coordinates)

About hw1

Aliasing and Anti-Aliasing

• This about an image where each pixels is fully black or 
fully white 

What if we rotate the rectangle 

• Some pixels are partially covered by the rectangle. Show 
they be rendered as black, white, or some shade of grey ?

What if we rotate the rectangle 

• IWe still need to assign a value to each pixel. 


• If we draw each partially covered pixel as black, we will obtain a very pixelated shape. This is an example of aliasing.  

• A possible solution is to render some pixels as gray. For example, based on the portion of its area which is covered.  This 
technique is call antialiasing.  Essentially, the color of a pixel might be determined using input from several neighboring pixels.


•  We will study much much more about it. Do not worry about it in hw1.   


• In hw1, each rendered pixel has the (rgb) value of one (single) input pixel. No averaging or mixing. 

Something to be careful about with hw1



Translations (shift) by(α, β)

• Adding a constant  to the x-coordinate of every point


• Adding a constant  to the y-coordinate of every point


•

α

β

(x, y) → (x + α, y + β)

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

(x=5,y=3)

(x=9,y=7)

Translation (shift) by (4, 4)
(x, y) ! (x + 4, y + 4)

Scaling
•We can use two constants (sx,sy) for the x-axis and the y-axis. Then we shift each 

point (x,y) into the point  


• 


•Example 

(sx ⋅x, sy ⋅y)

(x, y) → (sx ⋅x, sy ⋅y)

(x, y) → (x /2, y/2)

(6,6)

(3,3)

Scaling
•  Example:     (x, y) → (0.5x, 2y)

ç

(6,6)

(3,12)

The mathematician and coffee cup non-funny joke

Part 1


Empty Coffee 
 cup Full Coffee Kettle

Mathematician 

Fence 

Solution:  
1. Walk around the fence,  
2. fetch coffee kettle,  
3. walk back pure coffee,  
4. drink

The mathematician and coffee cup non-funny joke

Part 2


Empty Coffee 
 cup

Full Coffee 
 Kettle

Fence 

Solution:  
1. Bring the coffee Kettle to the other table, and walk to the left table   
2. Apply the solution from the previous slide 

Resize the clock, without 
changing its center 

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

Problem: scale the clock, but without changing its center and without e↵ecting the green rectangle



Solution - in 3 steps 

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

Translate by (�5,�5).
Now the center of the clock is on
(0, 0)

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

Scale by (2, 2)
(x, y) ! (2x, 2y)

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

Translate by (+5,+5).
Now the center of the clock
is back (5, 5)

from here

to here

to here

from here

Shearing
• If we move each point (x,y) into the point 

(x, y) → (x + y, y)

Shearing
• Vertical shearing shifts each 

column based on the x value.

(x, y) → (x, x + y)

Rotation
• Rotate counterclockwise by an angle 𝜙 about the origin.
(x, y) → (x cos ϕ−y sin ϕ, x sin ϕ+y cos ϕ)

New x New y 

Assume we rotate p by an angle   CCWθ

x = cos(�)

y = sin(�)
�

p = (x, y)
1

x0 = cos(� + ✓)

y0 = sin(� + ✓)

�

p0 = (x0, y0)

1

✓

x′￼ = cos(ϕ + θ) =

= x cos(θ) − y sin(θ)

Starting from a point p=(x,y), where will this point 
find itself after rotation by  in the 
CounterClockwise direction ? 


Let  denote the new location of this 
point.  Lets compute this location: 

θ

p′￼= (x′￼, y′￼)

cos(ϕ)

=x

cos(θ) − sin(ϕ)

=y

sin(θ) =

y′￼ = sin(ϕ + θ) =
sin(ϕ)

=y

cos(θ) + cos(ϕ)

=x

sin(θ)

= x sin(θ) + y cos(θ)

phi←

theta
←

18

Transformation Composition

❑ What operation rotates by θ around P = (px,py) ?

Translate P  to origin

Rotate around origin by θ 

Translate back

P P



Reflection on the x-axes:   (x, y) → (x, − y)

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9

(x=5,y=3)

(x=5, y= -3)

y = 1

y = 3

y = 5

y = 7

y = 9

x=1 x=3 x=5 x=7 x=9
y = �1

y = �3

y = �5

y = �7

y = �9

y = �1

y = �3

y = �5

y = �7

y = �9

Arbitrary Reflection - promo

We will get back to it later in the semester 

1. Compute b.

2. Shift by (0,-b)

3. Rotate by –α CCW
4. Reflect through x

5. Rotate by α

6. Shift by (0,b)

P

P’
y=ax+b

α(0,b)

α=tan-1(a)

x

y

P

P’
y=ax+b

α(0,b)

x

y

Very scarrrrry….

Unless we represent 

transformation by matrices 

And then it is trivial

A Simple Mathematical 
Abstraction for Images

• We can abstract an image as a function, I


• I: R → V


• The domain, R, is a some continuous rectangular area 
(R ⊆ ℝ2) and the range,   


•  V, is a set of possible values.


• Since R is two dimensional, we can use I(x,y) to represent 
the value of the image at a position (x,y) ∈ R

Raster Images
• We digitize I(x,y) as an array of values, I[y][x], called 

pixels, for picture elements

NOTE: (0,0) is 
often the top 
left, not the 
bottom left!

How Do We Acquire 
Raster Images?

Light
• Is both: (1) particles known as photons that (2) act as waves.


• Amplitude (height of wave)


• Wavelength (distance of which wave repeats)


• Frequency is the inverse of wavelength


• Relationship between wavelength (λ) and frequency (f):


• λ = c / f


• Where c = speed of light = 299,792,458 m / s



Light Light is Electromagnetic Radiation

• Visible spectrum is 
“tiny”


• Wavelength range: 
380-740 nm

Color != Wavelength
• But rather, a combination of wavelengths and energy

Isaac Newton, 1666

http://www.webexhibits.org/colorart/bh.html 
https://www.clivemaxfield.com/diycalculator/popup-m-cvision.shtml http://www.thestargarden.co.uk/Newtons-theory-of-light.html

Optics: Thin Lenses
• A lens is a transparent device that allows light to pass 

through while causing it to either converge or diverge.


• Given a camera, a target object, and a single converging lens:


• Let S1 and S2 be the distance from the lens to the target 
and film


• The focal length, f, is a measure of how strongly a lens 
converges light


• The magnification factor, m = S2/S1, relates the two 
distances.



Thin Lens Equation Human Optics
• In human vision, the cornea acts as a 

protective lens that roughly focuses 
incoming light


• Iris controls the amount of light that 
enters the eye


• The lens sharply focuses incoming light 
onto the retina


• Absorbs both infrared and ultraviolet 
light which can damage the lens


• The retina is covered by 
photoreceptors (light sensors) which 
measure light

The Eye

LENS

RETINA

Text

Not like a camera

Photoreceptors
• Rods (detect low-light / scoptopic vision)


• Approximately 100-150 million rods (Non-
uniformly distributed across the retina)


• Sensitive to low-light levels (scotopic 
vision)


• Cones (detect day-light / phototopic vision)


• Approximately 6-7 million cones.


• Detect color with 3 different kinds:


• Red (L cone) : 564-580nm 
wavelengths (65% of all cones)


• Green (M cone) : 534-545nm (30% of 
all cones)


• Blue (S cone) : 420-440nm (5% of all 
cones)

From Humans to Machines:

Charge-Coupled Devices (CCDs)

• A CCD is an electronic circuit 
with a grid of small 
rectangular photocells.


• The optical lens focuses a 
scene onto the sensors.


• Each photocell measures the 
amount of light that hits it.


• The collective data of the 
sensors represents an image 
when viewed from a distance.

http://en.wikipedia.org/wiki/Charge-coupled_device

Color Image Acquisition Color Image Acquisition
• In a single CCD color digital camera each individual 

photosite of the CCD is filtered to detect either red, green, 
OR blue light


• Most filters mimic the cone density of the human eye


• The Bayer filter uses 50% green and 25% red and blue 
sites.


• The ‘RAW’ data must be demosaiced (fill in the gaps) to 
produce a true-color image. 



Bayer Filter

• Newer technology allows each photosite is able to 
discriminate and measure red, green and blue light 
simultaneously.  

How Do We Encode 
Raster Images? • Bitmap: digital image that is a 2d array of pixels which store 

one bit.


• Simplest digital image, a representation of a black and 
white image.


• Bit: ones/zeros, convention is 0 = black & 1 = white.

Bitmaps

Digital Images Linearized
• While we think of images as 2-

dimensional, in memory we 
usually prefer to pack storage 
so that they are 1-dimensional.


• The same image can be 
represented in both binary and 
hexadecimal

Greyscale Images - Pixmaps

• We use 0 for black and 1 for white -- what value should 
we use for grey?  


• Could use floating point numbers


• Instead, one convention is to use 8 bits for pixel -- how 
many different “shades of grey”?


• Can convert to [0.0,1.0] by dividing by 255

Javascript and Arrays

• Standard Array type in Javascript is sparse:


• No guarantee of contiguous block of memory, memory is allocated on 
demand.


• Can store mixed types


• Javascript TypedArray does use a contiguous block of memory


• But, requires a fixed type. E.g. Byte, 



The operation Array.from
Definition and Usage

The Array.from() method returns an Array object from any object with a length property or an iterable 
object.


Create an Array from a String:

var myArr = Array.from("ABCDEFG");


Definition and Usage

The Array.from() method returns an Array object from any object with a length property or an iterable 
object.

Syntax

B=Array.from(object, mapFunction, thisValue)


B=Array.from([1, 2, 3], x => x + x)

console.log(B);

Output:   Array [2, 4, 6]


function f() {

  return Array.from(arguments);

}

f(1, 2, 3);

// [ 1, 2, 3 ]

Array.from() is not supported in Internet Explorer 11 (or earlier).

Image Allocation
let ROWS = 8;

let COLS = 8;

let pixmap2 = Array.from(Array(ROWS), () => Array(COLS));


pixmap2

pixmap2[3]

Rows separated in 
memory!

pixmap2[2]

pixmap2[4]

......

pixmap2[2][3]

But it’s even worse since 
individual elements likely 
are not adjacent either!

 

  let ROWS = 8; let COLS = 8;


  //pixmap is an array of arrays

  let pixmap = [];

  for (let r = 0; r < ROWS; r++) {

    pixmap[r] = [];

  }


  //pixmap2 is an array of arrays, but with lengths specified

let pixmap2=Array.from(Array(COLS), ()=>new Array(COLS)) 


  //pixmap3 is utilizes a 1-d array for the whole thing

  let pixmap3 = Array(ROWS * COLS);


  //top left pixel (x,y) = (0,0)

  pixmap[0][0]; pixmap2[0][0]; pixmap3[0];


  //top right pixel (x,y) = (7,0)

  pixmap[0][7]; pixmap2[0][7]; pixmap3[7];


  //bottom left pixel, in general [index] = [y*COLS+x]

  pixmap[7][0]; pixmap2[7][0]; pixmap3[56];


Pixmap 
Declaration


In Javascript

Pixmap Declaration with TypedArrays

pixmap4[2]

let ROWS = 8; let COLS = 8;


//pixmap4 is utilizes a 1-d array for the whole thing


let pixmap4 = new Uint8Array(ROWS*COLS); 


//Instead of storing as 0..255, can use other types


//e.g. Uint8ClampedArray, Float32Array, etc.


// Clamped here means “automatic and reasonable rounding: 


// -3.9-> 0;      266.5->255 etc”


//Can we do multidimensional TypedArray 


//using Arrays of arrays?


let pixmap4 = new Uint8Array(ROWS);


pixmap4[0] = new Uint8Array(COLS);    //incorrect!


//for TypedArrays, we must use 1-d indexing


//e.g. [index] = [y*COLS+x]

Image Allocation
let ROWS = 8;

let COLS = 8;

let pixmap4 = Uint8Array(ROWS*COLS); 

pixmap4

pixmap4[3] Memory contiguous, 
but cannot index by 

row / column

pixmap4[2]

pixmap4[4]

pixmap4[2][3]
We don’t have this

Encoding Color Images

• Could encode 256 colors with an unsigned char.  But 
what convention to use?


• One of the most common is to use 3 channels or bands


• Red-Green-Blue or RGB color is the most common -- 
based on how color is represented by lights.


• Coincidentally, this just happens to be related to how our 
eyes work too.

NOTE: There are many schemes to represent color, most 
use 3 channels.  We’ll come back to this next lecture



RGB Colors

• Additive Mixing 
of 3 Lights

Think about black background

RGB Color Cube

Encoding Color Channels

• Could use 8-bits, spread across all 3 channels (a bit 
ugly…)


• The textbook outlines a collection of other methods.  The 
most common?  8-bit RGB images (24-bits per pixel)

//separate channel encoding


let red_pixmap = new Uint8Array(ROWS*COLS);


let green_pixmap = new Uint8Array(ROWS*COLS);


let blue_pixmap = new Uint8Array(ROWS*COLS);


//all together, could use an 32-bit uint,


//by standard convention we have 4 channels


let rgb_pixmap = new Uint8Array(4*ROWS*COLS);


//access colors


let index = COLS*r + c; 


rgb_pixmap[4*index + 0];  //red


rgb_pixmap[4*index + 1];  //green


rgb_pixmap[4*index + 2];  //blue


     Alpha channel is skipped 


RGB Pixmap 
Encoding 
Options

How Do We Display 
Raster Images?



Optical Mixing
• To make (almost) any color, we combine light from three 

channels, Red, Green, Blue

As pixels get smaller, the 
light blends

LEDs 
(Light-Emitting Diodes) LCD Technology

• LCDs or Liquid Crystal 
Displays produce color 
by selectively blocking 
light through different 
filters


• Pixels are organized in 
various units of 3

• Light oscillates as a wave in all directions perpendicular to 
its path.  Polarizers selectively block certain oscillations

Polarized Light

http://www.olympusmicro.com/primer/lightandcolor/polarization.html

Twisted Nematics

ON

OFF

Black

Lit

LCD Technology
• Four basic layers (in twisted nematics 

displays):


• (1) Vertical filter film to polarize the light as it 
enters/exits.


• (2 – 4) Glass substrate sandwiched with 
electrodes. The activation of these 
electrodes will determine what light will 
penetrate via twisted nematic LCDS


• (5) Horizontal polarizer to filter light.


• (6) Reflective surface or light source to send 
light back to viewer.

http://en.wikipedia.org/wiki/Lcd



Sidebar: Framebuffers are used to 
prepare image data for the screen
• A framebuffer is an array of memory, large enough to store 

an image on the screen.  Often implemented in hardware.


• A lookup table or LUT converts information from memory to 
actual color responses on the display.


• Uses:


• Color correction, since display may not respond at the 
same levels as how the data represents it.


• Simple example: Gamma corrections, brightness/contrast 
adjustment, etc.

• Individual respond from the display (monitor) to every value of GrayScale

• Lets normalize the intensity by using float in [0,1] instead of 255 values of RGB

•  such that 

• 0 = black, and 1=white

• A pixel with input intensity  0.5 might look very different in different devices. 

• Furthermore, the individual  response is always monotonic but usually  not linear.  
• On top of it, viewer/illumination/other environmental factor 

• So is there a subjective definition of what is gray (middle between white and black) ?

• Gamma-Correction. We will assume approximately that if the input is a then

gamma-Correction 

• a here is the input intensity to the monitor (between 0 to 1)

•  is a constant the user could change, 

• If no gamma-correction is needed,  then the left and right should look 

the same (when viewed from a distance) 

• Change a continuously to the right region, until the output  looks like 

the left region.

• If this happens for some value a of input intensity, we deduce that

• ,  or 

• Now every new image, with intensity a’ , will be displayed using intensity 

 

γ

aγ

aγ = 0.5 γ = (ln 0.5)/(ln a)

(a′￼)1/γ

Chessboard of 
black/white 

pixels

Uniform region with grey 
pixels, all get input of 0.5 
(before correction). 


RGB Color Space
• Additive, useful for computer monitors


• Not perceptually uniform


• For example, more “greens” than “yellows”

mixture of the red, green, and blue (rR, gG, bB) primaries look identical. Figure 4.4
illustrates the concept. Three projectors are set up with overlapping beams. In the fig-
ure, the beams only partially overlap so that the mixing effect can be illustrated, but in
a color-matching experiment they would overlap perfectly. To match the lilac-colored
sample, the projectors are adjusted so that a large amount of light comes from the red
and blue projectors and a smaller amount of light comes from the green projector.

(a) (b)

G + B
+ R

Figure 4.4 A color-matching setup. (a) When the light from three projectors is combined
the results are as shown. Yellow light is a mixture of red and green. Purple light is a mixture
of red and blue. Cyan light is a mixture of blue and green. White light is a mixture of red,
green, and blue. (b) Any other color can be matched by adjusting the proportions of red,
green, and blue lights.

R

G

B

(r, g, b)

Figure 4.5 The three-dimensional space formed by three primary lights. Any internal color
can be created by varying the amount of light produced by each of the primaries.

Color Measurement 99

Converting from RGB to CMY

• Assuming RGB values are normalized (all channels 
between [0,1]), the exact same color in CMY space can 
be found by inverting:

Converting from CMY to CMYK

• Assuming CMY values are normalized (all channels 
between [0,1]), the exact same color in CMYK is


• K is a measure of the ‘blackness’ of the color and 
essentially serves as an offset after which the remaining 
amounts of cyan, magenta and yellow are ‘added’

(H,C/S,L/B/V) Color Space
• Hue - what people think of 

as color (color, normalized 
by sensitivity) 


• Saturation - purity, 
distance from grey


• Also called Chroma 


• Lightness - from dark to 
light


• Also Brightness or Value

Hue wheel (credit: Wiki) 
(not a single frequency)

The HSL color space was invented for television in 1938 by Georges Valensi as a method to add color 
encoding to existing monochrome broadcasts, allowing existing receivers to receive new color broadcasts 
(in black and white) without modification as the luminance (black and white) signal is broadcast unmodified. 
It has been used in all major analog broadcast television encoding including NTSC, PAL and SECAM and all 
major digital broadcast systems and is the basis for composite video. 



CSC 433/533

Computer Graphics

Anti-Aliasing and 

Signal Processing


Sampling,  Smoothing and Convolutions

Recall:

Images are Functions

Domains and Ranges
• All functions have two components, the domain and 

range.  For the case of images, I: R → V


• The domain is: 


• R, is some rectangular area (R ⊆ ℝ2) 


• The range is:


• A set of possible values.


• …in the space of color values we’re encoding

Hi Everyone! Operations on Images
• Point (Range) Operations:


• Affect only the range of the image (e.g. brightness)

• Each pixel is processed separately, only depending on the color

Slides inspired from Fredo Durand

Operations on Images
• Domain Operations:


• Only move the pixels around

Slides inspired from Fredo Durand



• Neighborhood operations:


• Combine domain and range

• Each pixel evaluated by working with other pixels nearby

Operations on Images
Slides inspired from Fredo Durand

Concept for the Day:

Pixels are Samples of 

Image Functions

Image Samples

• Each pixel is a sample of what?


• One interpretation: a pixel represents the intensity of 
light at a single (infinitely small point in space)


• The sample is displayed in such a way as to spread the 
point out across some spatial area (drawing a square of 
color)

Continuous vs. Discrete

• Key Idea: An image represents data in either (both?) of


• Continuous domain: where light intensity is defined at 
every (infinitesimally small) point in some projection 


• Discrete domain, where intensity is defined only at a 
discretely sampled set of points. 


• This seem like a philosophical discussions without clear practical  
applications. Surprisingly, it has very concrete algorithmic  
applications. 

Converting Between Image Domains

• When an image is acquired, 
an image is sampled from 
some continuous domain 
to a discrete domain. 


• Reconstruction converts 
digital back to continuous.


• The reconstructed image 
can then be resampled 
and quantized back to the 
discrete domain.

//scale factor


let k = 4;


//create an output greyscale image that is both


//k times as wide and k times as tall


Uint8Array output = new Uint8Array((k*W)*(k*H));


//copy the pixels over


for (let row = 0, row < H; row++) {


   for (let col = 0; col < W; col++) {


      let index = row*W + col;


      let index2 = (k*row)*W + (k*col);  


      output[index2] = input[index];


   }


}

Naive Image 
Rescaling Code



What’s the Problem?

• The output image has gaps!


• Why: we skip a many of the pixels in the output.


• Why don’t we fix this by changing the code to at least put 
some color at each pixel of the output?

//scale factor


let k = 4;


//create an output greyscale image that is both


//k times as wide and k times as tall


Uint8Array output = new Uint8Array((k*W)*(k*H));


//copy the pixels over


for (let row = 0, row < H; row++) {


   for (let col = 0; col < W; col++) {


      let index = row*W + col;


      let index2 = (k*row)*W + (k*col);  


      output[index2] = input[index];


   }


}

Naive Image 
Rescaling Code

//scale factor


let k = 4;


//create an output greyscale image that is both


//k times as wide and k times as tall


Uint8Array output = new Uint8Array((k*W)*(k*H));


//Loop over each output pixel instead.


for (let row = 0, row < k*H; row++) {


   for (let col = 0; col < k*W; col++) {


      let index = (row/k)*W + (col/k);


      let index2 = row*k*W + col;  


      output[index2] = input[index];


   }


}

“Inverse” Image 
Rescaling Code Inverse Image Rescaling

100x100 image

Not great, but could become worse

400x400 image

What’s the Problem?

• The output image is too “blocky”


• Why: because our image reconstruction rounds the index 
to the nearest integer pixel coordinates


• Rounding to the “nearest” is why this type of 
interpolation is called nearest neighbor interpolation



Sampling Artifacts / 
Aliasing

Motivation: Digital Audio
• Acquisition of images takes a continuous object and converts 

this signal to something digital


• Two types of artifacts:


• Undersampling artifacts: on acquisition side


• Reconstruction artifacts: when the samples are interpreted 

Undersampling Artifacts

Image Reduction
• Consider reducing the high resolution image:

Shannon-
Nyquist 

Theorem

(not needed for the 

exam)

• The sampling frequency must be double the highest 
frequency of the content.


• If there are any higher frequencies in the data, or the 
sampling rate is too low, aliasing, happens


• Named this because the discrete signal “pretends” to 
be something lower frequency

S-N Theorem IllustratedSampling Theory 
How many samples are enough to avoid aliasing? 

$ How many samples are required to represent 
a given signal without loss of information? 

$ What signals can be reconstructed without loss 
for a given sampling rate? 



S-N Theorem IllustratedSampling Theory 
How many samples are enough to avoid aliasing? 

$ How many samples are required to represent 
a given signal without loss of information? 

$ What signals can be reconstructed without loss 
for a given sampling rate? 

S-N Theorem IllustratedSampling Theory 
How many samples are enough to avoid aliasing? 

$ How many samples are required to represent 
a given signal without loss of information? 

$ What signals can be reconstructed without loss 
for a given sampling rate? 

S-N Theorem IllustratedSampling Theory 
How many samples are enough to avoid aliasing? 

$ How many samples are required to represent 
a given signal without loss of information? 

$ What signals can be reconstructed without loss 
for a given sampling rate? 

Shannon-Nyquist TheoremSampling Theorem 
• A signal can be reconstructed from its samples,  

iff the original signal has no content >= 
1/2 the sampling frequency - Shannon 

Figure 14.17 FvDFH Under-sampling 

Aliasing will occur if the signal is under-sampled 

Aliasing in images

Two outcomes of under-sampling 

1) Moire Pattern 
2) Rasterization 

Moire Patterns



Aliasing for edges

Each pixel is effected by nearby pixels  
For example, even though the input image image is black/white,  
We allow grey values for output pixels. 

Convolution

Each pixel is effected by nearby pixels  
For example, even though the image is black/white,  
We allow grey values 

Neighborhood Filtering 
(Schematic)

pixel i

f(Ni)

original image filtered image

neighborhood Ni of i

An Example: Mean Filtering
• Mean filters sum all of the pixels in a local neighborhood Ni and divide by the total number, computing the average pixel.


• Said another way, we replace each pixel as a linear combination of its neighbors (with equal weights!)


• To find  the  new color of a pixel j, we will look at  , defined as the (say)  neighborhood,  and set 


• Where the Ni is a square, we call these box filters


• Think  about  it  as  a weighted  average: 


• The weights  are convex combination. Meaning that they are all positive, and  . For  

example, 

Nj 3 × 3

w1…wk w1 + w2 + …wk = 1

w1 = w2 = w3 =
1
3

f(Nj) =
1

|Nj | ∑
pk∈Nj

Ck

f(Ni) = ∑
pixel j in the rergion N i 

wjCj

Box Filtering Box Filtering



Convolution
• This process of adding up pixels multiplied by various 

weights is called convolution

1 3 2
1 2 2
3 1 2kernel H

new pixel color = 30/16

original image G filtered image G*H

neighborhood Ni of i

1/16
1 2 1
2 4 2
1 2 1

Kernels
• Convolution employs a rectangular grid of coefficients, 

known as a kernel


• Kernels are like a neighborhood mask, they specify which 
elements of the image are in the neighborhood and their 
relative weights.


• A kernel is a set of weights that is applied to 
corresponding input samples that are summed to 
produce the output sample.


• For smoothing purposes, the sum of weights must be 1

1
9 (

1 1 1
1 1 1
1 1 1) 1

37

1 1 1 1 1
1 2 2 2 1
1 2 5 2 1
1 2 2 2 1
1 1 1 1 1

1
13 (

1 1 1
1 5 1
1 1 1)

One-dimensional Convolution

• Can be expressed by the following equation, which takes a filter H and 
convolves it with G:


• Equivalent to sliding a window

0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6 1.8 2
0

0.002

0.004

0.006

0.008

0.01

0.012Low pass and hight pass filters

0 10 20 30 40 50 60 70 80 90 100
-4

-2

0

2

4
original signal y

0 10 20 30 40 50 60 70 80 90 100
-4

-2

0

2

4
Low Pass filter. Signal y after convolution with gaussian

0 10 20 30 40 50 60 70 80 90 100
-4

-2

0

2

4
signal vs. High Pass Filter:  y-conv(y,w)

We convolved the 
original signal y with 
this gaussian

0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6 1.8 2
0

0.002

0.004

0.006

0.008

0.01

0.012Low pass and hight pass filters - another example 

We convolved the 
original signal y with 
this gaussian

0 10 20 30 40 50 60 70 80 90 100

0

2

4

6

original signal y

0 10 20 30 40 50 60 70 80 90 100
0

2

4

6
Low Pass filter. Signal y after convolution with gaussian

0 10 20 30 40 50 60 70 80 90 100
-2

0

2

4

6
  High Pass Filter:  y-conv(y,w)

Convolution is a 
Moving, Weighted 

Average

• Mathematically, this is 
equivalent to 
integrating the product 
of a and b with a shift 
in the domain


• Compare a to a*b on 
the right



2-Dimensional Version
• Given an image a and a kernel b with (2r+1)2 values, the 

convolution of a with b is given below as a*b:


• The (i-i’) and (j-j’) terms can be understood as reflections 
of the kernel about the central vertical and horizontal axes.


• The kernel weights are multiplied by the corresponding 
image samples and then summed together.

A Note on Indexing
• Convolution reflects the filter to preserve orientation. 


• Correlation does not have this reflection.


• But we often use them interchangeably since most kernels are symmetric!!

G*H

Given kernel H = 
Convolution reflects 
and shifts the kernel

An Illustration

An 
Illustration

Convolution Can Also Convert 
from Discrete to Continuous

• Discrete signal a


• Continuous filter f


• Output a*f defined 
on positions x as 
opposed to 
discrete pixels i

Back to Image Rescaling

100x100 image



Filtering helps to reconstruct 
the signal better when rescaling

Reconstructed w/ Discrete-to-ContinuousInverse Rescaling

//scale factor


let k = 4;


//create an output greyscale image that is both


//k times as wide and k times as tall


Uint8Array output = new Uint8Array((k*W)*(k*H));


//Loop over each output pixel instead.


for (let row = 0, row < k*H; row++) {


   for (let col = 0; col < k*W; col++) {


      let x = col/k;


      let y = row/k;


      let index = row*k*W + col;  


      output[index] = reconstruct(input,x,y);


   }


}

Discrete-Continuous 
Image Rescaling Code

Types of Filters:

Smoothing

Smoothing Spatial Filters
• Any weighted filter with positive values will smooth in some way, examples:


• Normally, we use integers in the filter, and then divide by the sum 
(computationally more efficient)


• These are also called blurring or low-pass filters

Smoothing Kernels Box Filter
Box filter

⌦

Thursday, February 16, 12

Note this brown strip



Gaussian Filter
Nice and smooth: Gaussian

⌦

Thursday, February 16, 12

Same brown strip

Gaussians
• Gaussian kernel is parameterized on the 

standard deviation σ


• Large σ’s reduce the center peak and spread 
the information across a larger area


• Smaller σ’s create a thinner and taller peak


• Gaussians are smooth everywhere.


• Gaussians have infinite support


• >0 everywhere


• But often truncate to 2σ or 3σ


• Volume =1 (sum of weights =1)

http://en.wikipedia.org/wiki/Gaussian_function

Smoothing Comparison

Smoothing the Smoothing 
Filters

• Box * Box = Tent (Pyramid)


• Tent * Tent = Bell Types of Filters:

Sharpening

Sharpening (Idea)Sharpening

- =

=+k*

High pass

Sharpened 
image

Input blurred

High passInput

Thursday, February 16, 12



Another example
Original Image,     Imaged convolved

Left: difference (only boundaries are non-black)  
Right   Imaged minus differences convolved

Sharpening is a Convolution
• This procedure can then expressed as a single kernel


• Assume that I = I*d and Ilow = I*fg,σ.

• d is the discrete identify function (kernel with 1 in center, 0 elsewhere)

• fg,σ is a smoothing filter (e.g. Gaussian of width σ).


• This leads to:

Sharpening is a Convolution
Note: could also 

define d as





0 0 0

0 1 0

0 0 0





Unsharp Masks
• Sharpening is often called “unsharp mask” because 

photographers used to sandwich a negative with a blurry 
positive film in order to sharpen

http://www.tech-diy.com/UnsharpMasks.htm

Edge Enhancement
• The parameter 𝛂 controls how much of the source image 

is passed through to the sharpened image. 

Defining Edges
• Sharpening uses negative weights to enhance regions where 

the image is changing rapidly


• These rapid transitions between light and dark regions are 
called edges


• Smoothing reduces the strength of edges, sharpening 
strengthens them.


• Also called high-pass filters


• Idea: smoothing filters are weighted averages, or integrals.  
Sharpening filters are weighted differences, or derivatives!



Edges (Review?) Derivatives via 
Finite Differences

• We can approximate the derivative with a kernel w:

∂f(x, y)
∂x

≈
f(x + h, y) − f(x − h, y)

2h
≈

f(x + 1,y) − f(x − 1,y)
2

Taking Derivatives with Convolution

Gradients with Finite Differences
• These partial derivatives approximate the image gradient, ∇I.


• Gradients are the unique direction where the image is changing the 
most rapidly, like a slope in high dimensions 


• We can separate them into components kernels Gx, Gy.  ∇I = (Gx, Gy)

Gradients Gx, Gy
Gradient: finite difference

• horizontal gradient [[-1, 1]]
• vertical gradient:  [[-1], [1]]

Horizontal 
gradient
(absolute 

value)

Vertical 
gradient
(absolute 

value)

Gradient 
magnitude

Thursday, February 16, 12

|Gx| |Gy|

|G| = √(Gx2 + Gy2)

|G|



Effects of 
Rescaling Why Use Both 𝛂, 𝛃?

• Consider two rescaled source 
samples of S rescaled to S’.


• Calculate the contrast (the 
absolute difference) between the 
source and destination, called 𝚫S 
and 𝚫S’.


• Now consider the relative change 
in contrast between the source 
and destination.

Why Use Both 𝛂, 𝛃?
• The relative change in contrast can be simplified as


• Thus, gain (𝛂) controls the change in contrast.  


• Whereas bias (𝛃) does not affect the contrast


• Bias, however, controls the final brightness of the rescaled image.  Negative bias 
darkens and positive bias brightens the image

Sidebar: Relating 
Contrast Sensitivities to 

Signal Processing

Contrast Sensitivity Function

Campbell-Robson Chart
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Contrast Sensitivity Function

Campbell-Robson Chart
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Where the bands   
can be distinguished 
depends on both the 
person and distance



Contrast Sensitivities Vary by Channel

4

Contrast Sensitivity Function (CSF)

Tuesday, March 6, 12

Photoshop demo
• Image > Mode > Lab color
• Go to channel panel, select Lightness
• Filter > Blur > Gaussian Blur , e.g. 4 pixel radius

–very noticeable
• Undo, then select a & b channels
• Filter > Blur > Gaussian Blur , same radius

–hardly visible effect

Original Blur Lightness Blur a & b
Tuesday, March 6, 12

Important: Clamping

• Rescaling may produce samples that lie outside of the 
output images (e.g. below 0 or above 255 in 8-bit images)


• Clamping the output values ensures that the output 
samples are truncated to the 8-bit dynamic range limit


• Note that clamping does ‘lose’ information, since it 
truncates.

Rescaling 
Examples

gain = 1, bias = 55 gain = 1, bias = -55 

gain = 2, bias=0 gain = .5, bias=0 

Rescaling Color Images
• Often, it is desirable to apply different gain and bias values to each channel of a color image 

separately


• Example: A color image that utilizes the HSB (Hue-Saturation-Brightness) color model.


• 


• Since all color information is contained in the H and S channels, it may be useful to adjust 
ONLY the brightness, encoded in channel B, without altering the color of the image in any 
way. 


• Rescaling the channels of a color image in a non-uniform manner is also possible rescaling each 
color channel separately.

Credit “Learn Ui Design Blog”

Example: Gamma Correction

s = r𝛄



Putting it all together:  
Gain, Bias, and Gamma

• Cout = (𝛂Cin + 𝛃)𝛄


• 𝛂 is known as gain 
(exposure)


• 𝛃 is known as bias (offset)


• 𝛄 maps to a non-linear 
curve (gamma correction)

242 Chapter 4: Tonemapping

  y Controlling Photoshop’s Highlight Compression method

1 In the 32-bit Preview Options dialog box, set 
Method to Highlight Compression.

2 Choose IMAGE > ADJUSTMENTS > EXPOSURE 
and play with the sliders in the Exposure dialog. 
These sliders behave in a slightly different way 
than they normally do because highlight details 
always have the right of way. Nevertheless, they 
are extremely interactive and easy to control.

3 When you’re happy with the tonal distribution, 
just bake it all down by performing the bit depth 
conversion in the IMAGE > MODE menu with the 
Highlight Compression method. 

This mode works great when your major 
concern is to protect the highlight details. As 
long as Highlight Compression is activated as 
the display method, the histogram is always 
anchored on the brightest end. Exposure and 
Gamma sliders now control how steep the loga-
rithmic intensity decay across the midtones 

and shadows is. You can push exposure adjust-
ments much further than you normally could 
because highlights will only get increasingly 
compressed instead of blowing out to white. 
Even though this mode is listed as having no 
options, it is actually one of the most versatile 
and intuitive ones. You have the entire toolkit 

Figure 4-5: The trick for controlling the Highlight 
Compression method is to enable it in the View menu first.

Figure 4-6: Now Photoshop’s simple Exposure adjustment can be 
used to interactively tweak the look.

Figure 4-7: The actual tonemapping dialog has no options, 
but that’s okay. You don’t need them anymore.

Image of Photoshop from 
Christian Bloch - The HDRI Handbook 2.0

Dynamic Range

The World is a High Dynamic Range (HDR)
1:1

1:1,500

1:25,000

1:400,000

1:2,000,000,000

Examples
• Inside is too dark
• Outside is too bright

• Sun overexposed
• Foreground too dark

Tuesday, March 6, 12

Examples
Inside is too dark 

Outside is too bright

Sun overexposed 
Foreground too dark

Dynamic Range in Displays?

• Range of pure black vs. pure white?

Tuesday, March 6, 12

Dynamic Range in Displays?Picture dynamic range
• Typically   1: 20 or 1:50

–Black              is   ~ 50x darker than white

• Max 1:500

10-6 106

10-6 106

Real world

Picture

Low contrast
Tuesday, March 6, 12



Problem: Displaying the Information
• Problem: How should we map scene radiances (up to 1:100,000) to 

display radiances (only around 1:100) to produce a satisfactory image?


• Goal: match limited contrast of the display medium while preserving 
details


• Solution: Tone Mapping

Problem 2: Display the information
• Match limited contrast of the medium
• Preserve details

10-6 106

10-6 106

Real world

Picture

Low contrast

High dynamic range

Tuesday, March 6, 12

First solution: Linear mapping
• We will find the pixels with min and max intensity in the 

input image. 


• Map them to the min and max intensities of the display


• Everything in between is mapped linearly. 

Problem 2: Display the information
• Match limited contrast of the medium
• Preserve details

10-6 106

10-6 106

Real world

Picture

Low contrast

High dynamic range

Tuesday, March 6, 12

Without HDR + Tone Mapping

Without HDR & tone mapping

Tuesday, March 6, 12

No single global exFrom Durand and Dorsey. No single global exposure can preserve both the colors of the sky and the details of the

 landscape, as shown on the rightmost images. 

With HDR + Tone Mapping

With HDR & tone mapping

Tuesday, March 6, 12

Recap

Detail

Color

Intensity Large scale

Fast
Bilateral 
Filter
IN LOG

Reduce
contrast

Detail

Large scale

Color

Preserve!

Input HDR image Output

detail=
input log - large scale

Tuesday, March 6, 12

high frequencies

Soothing  
(using a Gaussian,  
box filter, or other) low frequencies

I(x, y) = Intensity

g(x, y) = h(x, y) ⋆ G

h(x, y) = I(x, y) − (I ⋆ G)

(α ⋅ g(x . y) + β)γ

Actually 
I(x, y) = log10(Intensity) (α ⋅ g(x , y) + β )γ + h(x , y)



Before

http://abduzeedo.com/20-beautiful-hdr-pictures

Not All Tone Mapping Produces Extreme 
Results, Sometimes Just Beautiful Ones

http://luminous-landscape.com/essays/hdr-plea.shtml

Check (recommended)

Tone Mapping

Question: But why do we need more than 100 levels of  intensity (luminance) if in the input file we only have 256 
values of intensities (RGB) ?


Answer: Not all file format has so few levels. 


Even PPM could have 2 bytes per channel, so 2562=65536 levels per channel.


Other formats gives much wider range:

Radiance RGBE Format (.hdr)

(145, 215, 87, 149)  = 

(145, 215, 87) * 2^(149-128)  = 

(1190000, 1760000, 713000) 

(145, 215, 87, 103)  = 

(145, 215, 87) * 2^(103-128)  = 

(0.00000432, 0.00000641, 0.00000259)   

Ward, Greg. "Real Pixels," in Graphics Gems IV, edited by James Arvo, Academic Press, 1994 

Radiance!format!(.pic,!.hdr,!.rad)!

Red Green Blue Exponent 

32 bits/pixel 

Slide stolen from Alyosha Efros who stole it from Paul Debevec

The Radiance map

Thursday, March 8, 12

The Radiance 
Map

Radiance Definition:  much of the 
power (in watts) is emitted by a cm2  
surface will be received by an optical 
system looking at that surface from a 
specified angle of view. 



Linearly scaled to
display device

Slide stolen from Alyosha Efros who stole it from Paul Debevec

The Radiance mapThe Radiance 
Map Approach: Visual Matching

• We do not need to reproduce the true radiance as long as 
it gives us a visual match.

Eyes and Dynamic Range
• We're sensitive to change (multiplicative)


• A ratio of 1:2 is perceived as the same contrast as a ratio 
of 100 to 200


• Use the log domain as much as possible


• But, eyes are not photometers


• Dynamic adaptation (very local in retina)


• Different sensitivity to spatial frequencies

Headlights 
are ON in 

both 
photos

Can we just scale?  Maybe!

• For a color image, try to convert the 
input (world) luminance Lw to a target 
display luminance Ld


• This type of scaling works (sometimes).  
In particular, it works best in the log 
and/or exponential domains


• log10(x)=1+log10(y) means x=10y 

• The base of the log is not important,  
as long as we are consistent in the 
mapping 
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What scale value to use? 
How about Gamma compression

• Cout = Cin𝛄, where 0 < 𝛄 < 1 applied to each R,G,B channel 


• Colors are washed out, why?

Naïve: Gamma compression
• X −> Xγ  (where γ=0.5 in our case)

• But… colors are washed-out. Why?
Input Gamma

applied 
independently 
on R, G & B

Tuesday, March 6, 12

Gamma compression on Intensity

• Colors ok, but details in intensity are blurry

Gamma compression on intensity
• Colors are OK, 

but details (intensity high-frequency) are muddy

Gamma on intensityIntensity

Color

Tuesday, March 6, 12



Oppenheim 1968, Chiu et al. 1993
• Reduce contrast of low-frequencies


• Keep mid and high frequencies

Oppenheim 1968, Chiu et al. 1993
• Reduce contrast of low-frequencies
• Keep mid and high frequencies

Reduce low frequencyLow-freq.

High-freq.

Color

Tuesday, March 6, 12

The halo nightmare
• For strong edges
• Because they contain high frequency

Reduce low frequencyLow-freq.

High-freq.

Color

Tuesday, March 6, 12

Our approach
• Do not blur across edges
• Non-linear filtering

OutputLarge-scale

Detail

Color

Tuesday, March 6, 12

Start with Gaussian filtering
• Here, input is a step function + noise

output input

€ 

J

€ 

=

€ 

f

€ 

⊗

€ 

I
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Gaussian filter as weighted average
• Weight of  ξ  depends on distance to x

output input

€ 

ξ

∑

€ 

f (x,ξ)

€ 

I(ξ)

ξ
x

x
ξ

€ 

J(x)

€ 

=
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The importance of convex combinations 

When we smooth, or interpolate we usually use wighted average.


J(x) = ∑
weight function

f(x, ξ) I(ξ)⏟
Intensity

Which functions could f(x, ) be - 


 

ξ

x is the point where we need the answer

 is nearby point  ξ

f(x, ξ) = max {0,
3
α2

−
3
α3

max( |x − ξ . x | , |y − ξ . y | )}

G(x, ξ . x, ξ . y) =
1

2πσ
e− 1

2σ2 (x−ξ.x)2+(y−ξ.y)2

We will try to make sure that sum of weights =1 (this is called convex combination)

See example of bilinear interpolation on the whiteboard

 is the width of the base of the pyramid. So in Fig(a), =4  α α



The problem of edges
• Here,          “pollutes” our estimate J(x)
• It is too different 

output input

x
ξ

Ι(ξ)
I(x)

Ι(ξ)

€ 

ξ

∑

€ 

f (x,ξ)

€ 

I(ξ)

€ 

J(x)

€ 

=
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• To correct it,  we will have to change the averaging. 


• Remember that during the smoothing,  we will first sum    for all point  near x.  


• To resolve the halo problem, We will avoid summing  if   is very far from    
∑ I(ξ) ξ

I(ξ) I(ξ) I(x)

Principle of Bilateral filtering
[Tomasi and Manduchi 1998]

• Penalty g on the intensity difference

output input

€ 

J(x)

€ 

=

€ 

1
k(x)

€ 

ξ

∑

€ 

f (x,ξ)

€ 

g(I(ξ) − I(x))

€ 

I(ξ)

x Ι(ξ)
I(x)
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Remember that the sum of weights must be 1. 
What to do if we skip some terms ?  
We will divide the total sum by k(x) 

 if a is close to b, and zero otherwiseg( |a − b | ) = 1

Bilateral filtering
[Tomasi and Manduchi 1998]

• Spatial Gaussian f

output input

€ 

J(x)

€ 

=

€ 

1
k(x)

€ 

ξ

∑

€ 

f (x,ξ)

€ 

g(I(ξ) − I(x))

€ 

I(ξ)

x ξ

x
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Remember that the sum of weights must be 1. 
What to do if we skip some terms ?  
We will divide the total sum by k(x) 

Bilateral filtering
[Tomasi and Manduchi 1998]

• Spatial Gaussian f
• Gaussian g on the intensity difference

output input

€ 

J(x)

€ 

=

€ 

1
k(x)

€ 

ξ

∑

€ 

f (x,ξ)

€ 

g(I(ξ) − I(x))

€ 

I(ξ)

x Ι(ξ)
I(x)
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Normalization factor
[Tomasi and Manduchi 1998]

• k(x)=

output input

€ 

J(x)

€ 

=

€ 

1
k(x)

€ 

ξ

∑

€ 

f (x,ξ)

€ 

g(I(ξ) − I(x))

€ 

I(ξ)

€ 

ξ

∑

€ 

f (x,ξ)

€ 

g(I(ξ) − I(x))
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